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1. CONTACTS AND CUSTOMER SUPPORT 
 
For information regarding operation, maintenance, calibration, or repair, please contact 
Foresite, Inc. at: 
 
Foresite, Inc. 
1982 South Elizabeth Street 
Kokomo, IN 46902 
(765) 457-8095 
C3support@foresiteinc.com 
www.foresiteinc.com 
 
 
For information regarding the ordering of consumables, please refer to the C3 
Consumables Reorder Information found in the C3 Documents folder on the computer 
desktop and included USB drive.  
 
To become fully acquainted with the operation and use of the C3, it is recommended that 
personnel within your organization become active in the following ways: 
 
 

• Visit the Foresite website to receive information concerning the C3 and future 
development plans.  Go to www.foresiteinc.com. 

 
• Contact Foresite staff with questions or concerns at C3support@foresiteinc.com. 

 
 
If any problems are encountered with this system please contact Technical Support at 
(765) 457-8095 or C3support@foresiteinc.com. 
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2. SPECIFICATIONS & SYSTEM DESCRIPTION 
2.1. Specifications 
 
Dimensions: 

 
23” W x 22” D x 21” H (59 cm x 56 cm x 53 cm) 

(with computer arm assembly removed, the height is 14” H (35 cm)) 
 
Weight: 
 Approximately 75 pounds (34 kilograms) 
 
Power Requirements: 
 100 to 240 V AC, 1 Φ 
 50 to 60 Hz 
 5.0 A @ 120 V AC 
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2.2. Shipping Contents 

 
 

• C3 system  
• Laptop computer with Microsoft Windows operating system and C3/C.I. Control 

Software 
• Support arm and tray for laptop 
• Detached C3 arm assembly 
• Electrical verification cells (high, medium and low current levels) 
• Purge cell  
• Purge collection jar 
• Blank Test Cup 
• Fun-tak  
• Power cord 
• USB Drive with C3/C.I. Documentation and software backup loaded 
• Allen wrenches (5/64” for steam head; 3/32” for access panels, 7/32” for 

Computer Arm) 
• Priming Syringe 
• Standard test cells (one box, 100 per box) 
• Caps for vials (one bag, 100 per bag) 
• Extraction vials - 2 mL (one box standard, 100 per box) 
• Extraction solution (two 1-liter bags standard) 
• Operating Manual 
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2.3. System Overview 
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2.4. Principles of Operation 
 
The information gathered when using the C3 is intended to provide 
a measure of the cleanliness of a localized region of the sample 
surface, for example a circuit board. In addition, the C3 extracts a 
sample of the effluent from that localized region that can be used in 
further ionic analysis (such as ion chromatography). 
 
The C3, in conjunction with the extraction solution, has been 
designed to achieve effective ionic residue removal using a heated 
delivery system that consists of 3 stages: 
 
1. Heat the extraction solution and deliver to the extraction site 
2. Soak to allow solubilization of ionic species 
3. Aspirate the solution into a collection cell 
 
This process cycle is repeated nine (9) times to allow effective 
removal of the surface contaminating residues from a region of 
approximately 0.1 in2. The extracted ionic residues are then 
collected for subsequent analysis. The nine cycles should produce a volume of effluent 
that will fill the cell reservoir to a level where the meniscus of the liquid falls into the 
lower solder mask regions of the test cell (see arrow in figure below) 
 
Simple “Clean” / “Dirty” analysis is performed using the C3 on-board 
measurement system. If more detailed analysis of residues is 
required, the extracted solution can be analyzed using more 
sophisticated techniques such as ion chromatography. 
 
The C3 on-board measurement system uses a sacrificial circuit board 
electrode, immersed in the extracted solution, to measure the 
electrical conductivity of the solution. By applying a known bias (10 
volts) across the electrode terminals, a leakage current between the 
traces can be measured. 
 
Using the results from both SIR (surface insulation resistance) and ion chromatography 
testing, a leakage current of 250 μA has been established to identify when a current 
leakage event has occurred. The default test parameter settings (250 µA and 120 sec.) 
produce relatively sensitive C3 tests and are commonly used on higher reliability 
electronics (e.g. IPC Class II and III). Another commonly used set of C3 test parameters 
is 500 μA and 60 seconds. These settings are used on electronics for less demanding 
applications and environments (e.g. IPC Class I). 
 
The design of the C3 assumes that the more corrosive or conductive the extracted 
residue, the quicker a current leakage event occurs. The less corrosive or conductive the 
residue, the longer it will take to reach a 250 µA event. 
 
The C3 system measures the time taken to reach a 250 µA current leakage event.  
Extensive testing has shown that C3 timing results that achieve the 250 µA event in less 
than 120 seconds correlate to residues that exceed the ionic contamination limits 
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established by Foresite, Inc. Such results are identified as unacceptable and the tested 
sample is considered “Dirty”. Timing events that take longer than 120 seconds to 
achieve a 250 µA current leakage event correlate to acceptable residue levels and that 
region of the sample surface is considered “Clean”. 
 

The Foresite C3 Corrosivity Index (C.I.) 
 The C.I. is an indicator of the cleanliness of a test site analyzed by the C3.  

The index is calculated by dividing the maximum current seen during the  
test by the elapsed time of the test. 

Foresite developed the C3®, a process control tool that assesses the presence of 
detrimental, corrosive and/or conductive, residues in a specific, selected test area (0.1 
in2) using nondestructive, extraction and testing techniques. The C3 is used both to 
assess incoming material cleanliness and to monitor assembly and repair processes. 
During a C3 test a graph is created, plotting leakage current across an electrode gap (in 
micro-amps) versus elapsed test time. The test is terminated if and when the current 
exceeds a programmed limit or the set total test time (usually 180 seconds) is reached. If 
the current exceeds the limit prior to a set decision time, the test result is “dirty”; 
otherwise, the result is “clean”. The maximum current read during the test and the 
elapsed time of the test are recorded. 

Foresite recommended C3 limits for “IPC Class I” product are a set current limit of 500.0 
µA and a set decision time of 60.0 seconds; therefore, the C.I. limit is (500.0/60.0) 8.33. 
In a C3 test example where the current stays low throughout the set total test time of 180 
sec. (e.g. a max. current reading of 225.0 µA), the result is a “Clean” passing C.I. of 
225.0/180.0 = 1.25, well below the 8.33 limit. In a test example where the current 
exceeds the set current limit prior to the set decision time (e.g. 550.0 µA at 50.0 sec.), 
the result is a “Dirty” failing C.I. of 500.0/50.0 = 10.0, above the limit. 

Using recommended C3 limits for “IPC Class II and III” product to further illustrate the 
C.I., with a set current limit of 250.0 µA and a set decision time of 120.0 seconds, the 
C.I. limit is (250.0/120.0) 2.08. Looking at a C3 test example where the current exceeds 
the set limit after the set decision time (e.g. 275.0 µA at 130.0 sec.), the result is a 
“Clean” passing C.I. of 250.0/130.0 = 1.92, below the C.I. limit. 

The factory default C3 limits are set with a current limit of 250 and decision time of 120 
seconds.  

Current values used in test C.I. calculations are limited to the set current limit for two 
reasons: 

1) A test current spike soon after the set decision time, if not limited to the set 
current limit, can result in a calculated C.I. above the C.I. limit, even though the 
test passed by having the current stay below the limit throughout the period prior 
to the set decision time; 
2) When a test current spikes, it can happen suddenly, usually as a result of a 
dendrite forming – so suddenly that the recorded max. current can vary 
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significantly between such test occurrences. Using the recorded max. current 
reading in such tests would result in erratic C.I. values that could mask trends. 

The Corrosivity Index (C.I.) provides a single test result value that can be plotted over 
time to track trending in product cleanliness – the lower the C.I. the less likely a tested 
product site will suffer performance problems due to the presence of a detrimental ionic 
residue.  
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3. INSTALLATION & PRE-OPERATION CHECKS 
 

3.1. Unpacking & Setup 
 
1. Remove all components from the shipping container. The Arm and Steam Head 

Assembly are wrapped in protective foam. The laptop computer, Articulating Arm and 
Computer Tray, Extraction Solution, and Test Cells are all boxed separately. 
 
Note: Consideration should be given to the environment in which the C3 is 
located – a site that is as free of contaminants and corrosive elements as 
possible, which could affect test results or the C3 unit, is best.  

 
2. Set up the Arm and Steam Head Assembly. 
 
3. Center the white spacer washer on the post. Place the arm/steam head on the 

stationary post as shown. Place the metal washer on the top of the arm and screw 
the wing nut down to secure the arm to the post. Adjust the tightness of the screw to 
control the ease of arm motion. 

 

 
 

4. Assemble the Computer Support Arm and Tray, and position the laptop on them per 
factory instructions provided.  

Insert main arm Attach tray to arm and attach washer under 
arm to tray 
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Place laptop in tray Slide back plate over laptop screen 

Tighten bottom screw into key-hole Screw in two key locks 

Completed arm with laptop 
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5. Connect the electrical, vacuum and water supply lines behind the test arm base. 
• The electrical connection for the test head is a keyed barrel connector. Rotate 

the connector until the keyed position is found. Insert to full depth and rotate 
locking barrel. 

• The vacuum connection is made with a push and click motion. When the fitting is 
fully seated, the retention clip will snap into place. 

• Thread the extraction solution tubing assembly into the base fitting. Twist the 
fitting until finger tight. 

• Attach the power cable to the connector on the back panel of the cabinet. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. Plug the USB cable into the USB port on the right side of the laptop.  
 
 
 
 
 
 
 
 
 
 
 
 
 
7. Remove the shipping cap from the extraction solution bag and replace it with the 

system one-way valve cap. Purge any air bubbles that are trapped in the solution 
bag by holding the bag upright and squeezing out the trapped air. The one-way valve 
will keep air from re-entering the bag. 
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8. Screw the system feed line onto the one-way valve by hand tightening. Lay the 
solution bag on its side in the fluid system drawer as shown. 

 
 
  
 
 
 
 
 
 
 
 
 
 

 
9. Plug the power cable into a 100 - 240 V power outlet. Turn the unit on using the 

power switch located on the left side of the enclosure. The unit should be operational 
at this point. 

 
 
 
 
 
 
 
 
10. Upon powering up the PC it should start and run the same as any office PC. Once 

the PC has started and loaded Windows, the C3 software icon should appear on the 
desktop. Click on the C3 desktop icon and the software should open and take you to 
the Test Homepage.  
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3.2. Initial System Navigation 
 
The C3 has many different options for operating via the PC interface. Those options 
control the system as shown below. 
 
The primary menu options found on the “Menu Tool Bar” are: 
 

• File  

 
 

• Edit 

 
 

• Calibration 

 
 

• View  
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• Control 

 
 

• Verification 

 
- See Section 4.5 for detailed Verification instructions 

 
• Data Analysis 

 
 

• Security 

 
 

Help 

 
- Selecting “C3 Help” will bring up the Software User’s Manual 
- Selecting About will bring up the C3 Software version 
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Detailed Descriptions of the Primary Menus 
 

File Menu 

 
 
In the file menu the user has the option to open or save test files as well as create or 
save Configurations.  
 
The Test Open/Save option allows the user to open a previously run test for review as 
well as save current test data to specific files via the browse option.  

 
Configuration files have file extensions .c3c. Test parameters and user information is 
stored in these files. To create a new configuration set, choose File – Configuration – 
New Configuration. To save a configuration file use File – Configuration – Save 
Configuration or use File – Configuration – Save Configuration As. To recall a 
configuration file use File – Configuration – Load Configuration.  

http://www.residues.com/
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The currently loaded configuration file name will be shown in the center of the status bar 
after it is loaded.  
 

 
   
The Quit selection in the File Menu will close the C3 program.  
 
 

Edit Menu 

 
 

The Edit menu option is where the user can input User/Customer information, adjust test 
parameters, and select preferences.  

 
 
 
 
 
 
 
 

 

http://www.residues.com/


 

18 
Foresite, Inc. ♦ (765) 457-8095 ♦ www.foresiteinc.com 

01-2020 – rev L 

User Information  
User/Customer information allows entry of customer and test information into the test 
database.   

Test Parameter Setup  
The Test Parameter Setup option is located in the “Edit” tab on the menu bar and allows 
for the inspection and changing of the default C3 system test parameter settings.  
Access to this screen is password controlled as described in the Security section.  
 

  
 
Please note that Foresite has factory set the test parameters to those which will 
provide standardized results that have been verified and correlated  from 
thousands of laboratory tests. While the option exists to adjust test parameters, 
Foresite strongly recommends consulting with technical service before doing so.  
Foresite cannot stand behind the results of regular operation using user modified 
test parameters.  
 
If the user selects the “Advanced” tab in the Test parameters it will give them the option 
to adjust items such as the pump cycle count, pump timing, and soak time. 
 
If at any time the user decides that they no longer want to keep the adjusted test 
parameters, they can simply click on the “Restore defaults” button on the bottom left of 
the dialog box and all of the test parameters will be returned to their Factory Default 
settings.  

http://www.residues.com/
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Preferences 
The Preferences option is where the user can select from different system options such 
as Auto Save Test Data, the directory location for test files, barcode scanning option, 
Temperature units, warnings, sounds, and the directory location to save cell pairing and 
validation data. 
 

 
 

Calibration Menu 
 

 
 
The Calibration menu is where the user can pair Validation cells to the C3 and 
electrically verify the machine. These options are password protected and can only be 
adjusted once the correct password has been entered in “Log In” under the Security 
menu. Refer to the security section for further information on Password “Log In”. The unit 
is delivered already Calibrated and the user should not access this function.  It is 
available for factory set up or field service purposes. Validation cells supplied with each 
C3 are paired to the unit prior to delivery and should be kept with the machine for weekly 
maintenance.  

http://www.residues.com/
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View Menu 
 

 
 

The view menu allows the user to select from different display options within the main 
test home screen. By checking the specific item it will select or de-select those items to 
be shown on the page. The checked items will be shown.  
 
 

Control Menu 
 

 
 

In the Control menu the user will have the option to activate/deactivate various pieces of 
equipment within the unit. This is where the user can select to start/stop a test, turn 
on/off the heat and vacuum, and toggle the pump line purge option. In this menu the 
user can also Set a new test number or Reset the test number back to zero. The Apply 
10 Volts selection is a troubleshooting tool and should only be used upon advice from 
Foresite. 
 
The “Pump Line Purge” provides the controls necessary to test and purge the solution 
extraction system. The number of purge cycles is set to two hundred and fifty (250) at 
the factory. This number can be changed if needed. Pressing the Start button will cause 
the system to purge that set number of cycles and the screen will show count status as it 
pumps. The user can also stop the purge at any time by clicking Stop.  
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Data Analysis 
 

 
 

The Data Analysis menu allows the user to graph and analyze previous/current test data 
for the desired test/date range. By selecting the Show CI Graph option the CI Graph 
Data Selection dialog box will open.  
 

 
 

Within the Graph Data Selection box the user can input or select various information 
pertaining to the desired test graph to be displayed. Please note that this information is 
case sensitive. The graphed data is based on the C.I. (Corrosivity Index) of the selected 
tests. The output will be a graph pertaining to the data specified in the query. 
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Likewise, by selecting the Save Summary Table option the Data Selection dialog box will 
open.  
 

 
 

The output of this query will generate an excel spreadsheet (HTML version unless the 
user loads MS Office onto the PC) showing the data pertinent to the search criteria. For 
example: 
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Security Menu 
 

 
 

The security menu is where the user can “Log in” to password protected functions of the 
C3. This menu is also where the user can change the access password.  
 
Note that the factory set password is the word “password”. 

 
 

 
 
In the “Log in” on the drop-down menu, the user has an option to select from “Test 
Parameters” or “Calibration”. “Test Parameters” allows the user access to Test 
Parameters under the Edit Menu. “Calibration” allows the user access to Calibration and 
Cell Pairing under the Calibration menu.  
 
 

 
 
 
 
 
 
 
 
 
 
 

http://www.residues.com/


 

24 
Foresite, Inc. ♦ (765) 457-8095 ♦ www.foresiteinc.com 

01-2020 – rev L 

To change the password from the factory default to one of your choosing, click on 
“Change Password”. 
 

 
 
 
Select which password is to be changed through the drop-down menu titled “Protected 
area”. 
 

    
 

Enter the old password, then the new password, finally confirming the new password. 
 

    

http://www.residues.com/


 

25 
Foresite, Inc. ♦ (765) 457-8095 ♦ www.foresiteinc.com 

01-2020 – rev L 
 

4. SYSTEM OPERATING PROCEDURES 
4.1. Initial System Checkout 
 
1. Ensure that the steps described in the Unpacking & Setup Section of this manual 

have been performed correctly and that the PC and monitor turn on.  
 

2. Verify that the extraction solution bag has a sufficient quantity of liquid and has been 
“purged” to remove any trapped air bubbles. Position the bag so that any remaining 
bubbles float away from the liquid outlet. 

 
3. Insert a test cell into the steam head as shown. Raise the head and with the 

collection reservoir facing the front of the head. Push the test cell up using the base 
of the reservoir until the top of the wings are in-line with the slots in the steam head 
housing (see arrow in photograph) and the cell feels firmly seated. Note – The wing 
may not seat inside the slots. This is ok. If the test cell is firmly seated and the wings 
align with the slots the fit should be proper. 

 
4. Handle the cell only by the wings or body of the cell. DO NOT handle the end seal as 

that is the part of the test cell that will be in contact with the sample being tested. 
Foresite recommends the use of clean, powder free vinyl gloves when handling test 
cells and samples. 
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5. As a standard practice, the extraction solution delivery system is purged two hundred 
and fifty (250) times prior to testing production samples. It is also recommended that 
a purge cycle be completed if the C3 has not been operated for 24 or more hours.  
Click the PURGE icon to enter the Purge Menu screen. As the number of purge 
cycles is set to 250 at the factory, the system is initially setup to perform this 
procedure. Press the Start button to begin the process. Collect the purged solution 
by placing the supplied collection jar under the steam head. The purged solution can 
then be properly disposed of once complete. 

 
6. As a way to ensure that the system electrical calibration has not been affected during 

shipping, a verification of system current calibration is to be performed (see the 
System Calibration/Verification Procedures Section of this manual). This verification 
consists of determining the actual measured current when each of the three 
Electrical Verification Cells (low, medium and high) are placed in the steam head. 

 
The resulting measured current values must fall within the limits set forth in the 
verification procedure.  
 

4.2. Standard Testing Procedure 
 
After the extraction solution system conditioning (purging) and the electrical verification 
testing are successfully completed, the C3 is ready to test production samples. 
 
Foresite recommends the use of an ESD strap when working with components or 
assemblies that may have highly sensitive static areas. The C3 is equipped with a 
common ground location for convenience. 
 
The C3 can be user configured to meet any particular extracting/testing condition that is 
desired. However, extensive field and laboratory experience has established a standard 
set of testing conditions to be used for the vast majority of situations. Those standard 
parameters are loaded into memory at the factory. 
 
Detailed instructions concerning changing the standard parameters are provided in the 
Adjustment of Standard Testing Parameters Section of this manual. The changing of 
these parameters is under password protection. 
 
1. Prior to beginning testing, the system must be allowed to warm up and stabilize. 

When the C3 and computer are powered up, the heater will automatically turn on and 
heat the steam generator to the preheat temperature. 
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The red LED on the steam head indicates that the heater is turned on. The light will 
first blink then stay on and finally begin to cycle again once the heater is at the set 
point temperature. Upon initially turning on the system, the heater temperature is set 
to the system preheat temperature. At the start of the first test, the heater 
temperature changes to the solution heater temperature and stays at that 
temperature until the system has been idle for 30 minutes (see Heater Timeout 
Interval in Test Parameters). Again, the heater will take several minutes to reach the 
desired extraction temperature. 

 
 
2. If User Information is to be input into the system database it should be done prior to 

starting a test or series of tests. This operation is accessed through the “Edit/User 
Information” tab. 
 

3. Place the sample to be tested on the ESD mat in such a location that the area-of-
interest is within reach of the steam head. 

 
4. Remove a test cell from the shipping tray, handling only by side wings on the cell.  

Insert the test cell as discussed previously. It is important that the cell be fully seated 
up into the steam head. 

 
 
5. Lower the steam head with the test cell onto the area to be tested. Make sure that 

the red seal is fully compressed. 
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6. Begin the test process by left clicking the green “Start” button of the main testing 

page. During testing a number of key parameters are displayed during this process. 

 
 
7. As shown, the temperature of the extraction solution heater is displayed. As the 

extraction process continues, the Machine Status, Sample Status, and Test Status 
data will change based on which phase of the extraction process is occurring. The 
extraction process will repeat the specified number of cycles as shown at Cycle. 
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8. As the test progresses, the measured current at each measurement interval (250 

ms) is plotted. Three resulting conditions are possible during testing. Those 
conditions are Clean, Dirty and Invalid. The two most likely outcomes are CLEAN 
and DIRTY. In the case of the clean event, the measured current did not exceed the 
specified Limit Current (μA) within the Check Current Time (sec). In the case of the 
dirty event, the specified Limit Current (μA) was exceeded in less than the Check 
Current Time (120 sec). 
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The third result condition INVALID is most likely caused by a solution extraction 
error. For example, the volume of liquid extracted up into the collection reservoir was 
not large enough to have the meniscus of the solution fall within the proper region of 
the test electrode (see photograph in Principles of Operation). If the extraction 
solution volume is not large enough to exceed the lower current threshold of 70 μA 
after the excitation voltage is applied, an INVALID test condition is the result.   
 
There are several likely reasons for a low liquid level. First, if open vias (non-tented 
or plugged) are present within the test region, the extraction liquid will flow through 
the circuit board. This is usually corrected by applying Kapton tape or Fun Tak™ 
putty to the back side of the board, sealing the vias. Second, the seal between the 
cell and the sample surface may be incomplete allowing liquid to leak out of the test 
area. Third, if the test cell is not fully inserted into the test head you may experience 
a “flat line” response indicating there is no connection of the C3 Test Cell coupon to 
the connector inside the test head. Check insertion depth of the C3 cell and burnish 
(scratch) marks on the coupon electrodes to confirm connection is being made with 
the connector. Finally, the extraction solution bag may be empty and need to be 
changed. 
 
Note: 
Only use Fun Tak brand putty and verified clean Kapton high temperature tape as 
other materials may affect your C3 measurements. 
 

9. At the completion of a test, it is necessary to save the data to the test database.  If 
this step is not completed, a record of that test will be lost. Press the Save Data 
button to store the current test data. Alternatively, the user can set up the user 
preferences to auto-save the data at the end of each test. 

 
Raise the steam head and push down on the ejector bar to release the test cell. 
Remove the cell by pulling down on the wings of the cell. 

 
10. In some cases, the collected sample is to be 

further analyzed using ion chromatography 
or some other chemical analysis test 
technique. In this case, snap off the retaining 
cap from the top of the test cell and transfer 
the sample to a clean sample vial. 

 
Care must be taken to not contaminate the 
vial or the vial cap by touching the rim or cap 
seal with bare hands. 
 

11. The majority of the extraction solution is taken up into the collection reservoir during 
testing leaving little liquid left on the test surface. Therefore, as a general statement, 
the part under test is left to air dry with no attempt to actively force clean or dry the 
tested region. If desired, the surface can be dried using a clean lab wipe or similar 
lint-free cloth. 
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4.3. Data Storage and Retrieval 
 
In order to keep a log of the testing that was conducted and of those results, it is 
necessary to save the results of each test before starting a new test. If a new test is 
started before the data is stored, the results of the previous test are purged from 
memory, unless auto save is set up by the user. 
 
To save a test the operator is to follow the same process as they would if they were 
saving a document on an MS office program. Locate the “File” tab on the top menu bar 
and click it to open the drop-down menu. Select “Test” and then the “Save” option and 
enter the desired file name in the dialog box labeled “File Name”. Click the “Save” button 
and the test will be saved under the given name in the desired location. The user can 
also save test data by simply clicking on the save icon on the tool bar at the top of the 
screen. However, by clicking the save icon it will not allow you to save the test as a 
special name and will only save it by the user information (customer name), test number, 
and date code.  
 

 
 
To load a test from previously saved data files the operator is to follow the same steps 
as above but instead of selecting “Save” they are to select “Open”. From there the 
operator can view a list of tests that have been saved and they can select the test for 
which they want to recall data. Once selected the program will redisplay the test results 
including the graphed results.  
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Capturing Test Data in PDF Format 
 
If the user desires to capture test results in PDF format the following steps should be 
followed.  
 

1. At the end of the test cycle save (or Auto-save) the test results. 
2. Click on File 

 

 
 

3. Select Export PDF 
 

 
 

4. If the file path is where you want the pdf to be located then add a file name and 
click on Save 
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5. The PDF will be saved to the folder you chose 
 

 
 

6. The saved PDF file is shown below: 
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4.4. Daily and Weekly Operational/Maintenance Checks 
 

Daily 
 

It is recommended that the solution extraction system be reconditioned each morning 
prior to running production tests. 
 
1. From the Test Homepage Screen select the Purge button. 
2. Install the blank test cell supplied with the machine into the steam head. Place the tip 

of the cell into the collection jar supplied with the C3 or a similar container. 
3. From the Purge Menu select the Start button and purge the system into the jar for 

250 cycles (system default value). 
 
This purge operation should ensure that the extraction solution used in testing is fresh 
from the solution bag and has not been in contact for long periods of time with the 
internal parts of the fluids system, providing the most repeatable test results. 
 
 

Weekly 
 
It is further recommended that the current measurement verification be performed 
weekly.   
 
Follow the procedure for Verification of System Current Calibration in the System 
Calibration/Verification Procedures Section of this manual. 
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4.5. Verification of System Current Calibration 
 
The accuracy of the measured sensor current is verified using the three electrical 
verification cells supplied with the C3. Those cells are matched to the serial number of 
the supplied unit.  
 
To perform an electrical verification first click on the Verification tab and select Verify  
Cells.  
 

 
 
 
Once the Verify Cells option has been selected it will populate a dialog box with guided 
instructions on how to properly verify the system. Insert each test validation cell into the 
steam head and follow the instructions.  
 

 
 
 
Upon completion of the Verification test, the system will show the measured values and 
indicate if the system has passed or failed the check. If each of the three current values 
fall within the specified limit of +/- 5 uA, the system is considered calibrated and 
acceptable for production use. When this testing is completed, close the dialog box.  
 
If a “Pass” is not indicated for one or more of the three validation cells, perform a Pairing 
operation of the cells and then perform the Verifiction procedure again.   
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4.6. Cell Pairing Procedure 
 
To Pair the Validation Cells, follow these steps: 
 
Login through the Security menu to Calibration 
 
 

 
 
 
Under the Calibration menu open Cell Pairing 
 

 
 
Follow the instructions in the pop up window for each of the three Validation Cells, Low, 
Medium, and High, provided with the machine. 
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After all three cells have been paired a Verification Test can be performed. 

 
If the Verification Test continues to fail after Cell Pairing then contact Technical Support 
at Foresite, Inc. for additional help. 
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4.7. Use of Priming Syringe Tool 
 
In rare instances the one way check valve on the extraction solution bag cap can 
become stuck shut.  When this happens the solution pump will not create a strong 
enough force to open it.  When this happens use the included Priming Syringe Tool to 
open the check valve to allow the flow of extraction solution through it. 
 

1. Obtain the Priming Syringe Tool 

 
 

2. Open the side drawer of the C3CI cabinet, exposing the extraction system. 
 
 

 
 
 
 
 
 

 
3. Remove the knurled fluid nut from the one way check valve on the solution bag 

cap.  Do not remove the cap from the solution bag. 
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4. Make sure that the syringe plunger is depressed into the syringe body.  Then 
screw the threaded end of the Priming Tool onto the one way check valve. 

 

 
 

5. Slowly pull the syringe plunger out until extraction solution begins to enter the 
syringe body. 

 
 

  
 

6. Unscrew the Priming Syringe tool, discard the solution in the syringe, and re-
assemble the one way check valve to the fluid line by screwing the knurled fluid 
nut into the valve.  Close the side drawer.  At this time a system purge is 
recommended. 
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User Notes 
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